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Deployment User Interface Reference

Depending on whether you are in Workflow mode or non-Workflow mode, the 
pages displayed in support of deployment differ. The following topics provide 
user interface reference information for these pages:

• Deployment—Non-Workflow Mode, page O-1

• Deployment—Workflow Mode, page O-9

Deployment—Non-Workflow Mode
The following topics provide details about the windows and dialog boxes used for 
deploying configurations and managing deployment jobs when using 
non-Workflow mode:

• Deployment Manager Window (Non-Workflow Mode), page O-2

• Deploy Saved Changes Dialog Box, page O-3

• Deployment Status Details Dialog Box, page O-6

• Preview Config Dialog Box, page O-8
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Deployment Manager Window (Non-Workflow Mode)
Use the Deployment Manager window to display a list of deployment sessions, 
view job details, deploy and redeploy configurations to devices, abort deployment 
jobs, and rollback to previous configurations on selected devices.

Navigation Path

Click the Deployment Manager button on the Main toolbar.

Related Topics

• Viewing Deployment Status Information, page 18-37

Field Reference

Table O-1 Deployment Manager Window (Non-Workflow Mode)

Element Description

Name Name of the job. Click a job name to display details about the job. Information 
is displayed under the Deployment Details tab.

Last Action Date and time that the job or status was changed.

Note Uses the time zone of the server, not the time zone of the client.

Status State of each job. For a list of valid states, see Job States in Non-Workflow Mode, 
page 18-4.

Changed By Name of the user who modified the job.

Description Description for each job.

Deploy button Deploys the generated CLI commands to the selected devices or files. When you 
click Deploy, the Deploy Saved Changes dialog box appears. For details about 
the elements on the page, see Deploy Saved Changes Dialog Box, page O-3.

Refresh button Reloads job information from the Security Manager server. The latest job 
information is displayed in the Deployment Job table.

Redeploy button Redeploys the generated CLI commands to the selected devices or files. When 
you click Redeploy, the Redeploy Job page appears. For details about the 
elements in the dialog box, see Redeploy a Job Dialog Box, page O-32.
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Deploy Saved Changes Dialog Box
Use the Deploy Saved Changes dialog box to select specific devices for 
deployment.

Caution You must configure at least one policy on a device before deploying to that device. 
If you deploy to a device without assigning at least one policy, the device's current 
configuration is overwritten with a blank configuration.

Navigation Path

Do one of the following:

• Select File > Submit and Deploy. If the validation results in errors, either 
click Cancel and resolve the errors before attempting to deploy again or click 
OK to proceed.

Abort button Aborts a job that is in the Deploying state. The Abort state is a final state; no 
other actions can be taken on the job. Click Abort to display the Abort 
Deployment Job dialog box. For details about the elements in the dialog box, see 
Abort Deployment Job Dialog Box, page O-28.

Rollback button Deploys the selected job again. Click Rollback to display the Deployment 
Rollback dialog box. For details about the elements on the page, see Deployment 
Rollback Dialog Box, page O-29.

Summary tab Displays summary information about the status of deployment jobs, such as the 
status of the job, number of devices deployed successfully, and number of device 
deployed with errors. For information about the elements displayed, see 
Summary Tab (Deployment Manager Window), page O-34.

Details tab Displays details about the deployment to specific devices, including information 
about errors, the proposed configuration, and the transcript of the download. For 
information about the elements displayed, see Details Tab (Deployment Manager 
Window), page O-35.

Close button Closes the dialog box.

Help button Opens help for this dialog box.

Table O-1 Deployment Manager Window (Non-Workflow Mode) (continued)

Element Description
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• Click the Deployment Manager button on the Main toolbar. Then click 
Deploy. If the validation results in errors, either click Cancel and resolve the 
errors before attempting to deploy again or click OK to proceed.

Related Topics

• Deploying Configurations in Non-Workflow Mode, page 18-38

• Previewing Configurations, page 18-43

• Job States in Non-Workflow Mode, page 18-4
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Field Reference

Table O-2 Deploy Saved Changes Dialog Box

Element Description

Devices Selector All devices for which policy changes were made but not yet deployed. To include 
devices in the deployment job, select the check box next to the desired device. To 
remove devices from the deployment job, deselect the check box. 

Note To preview the configuration for a device, right-click the device, then 
select Preview Config.

Also consider the following:

• If you select a subset of devices that are part of a VPN and click OK, a 
warning appears. See Warning - Partial VPN Deployment Dialog Box, 
page O-16.

• You cannot select devices that were included in other deployment jobs that 
are in an active state (Edit, Edit Open, and Approved). You can select devices 
that were included in other deployment jobs that are in the Deployed, Failed, 
Discarded, or Aborted states.

• In Catalyst 6500/7600, Firewall service modules (FWSMs) and Intrusion 
Detection System service modules (IDSMs) contain virtual devices. The 
module and the virtual devices are each considered by Security Manager to 
be separate devices.

• Some changes to the FWSM might require the Catalyst 6500/7600 
Multiservice function card (MSFC) to be updated as well. If you select a 
FWSM that has these types of changes, Security Manager notifies you that 
you must include the MSFC in the deployment job, and it will select the 
MSFC device for you automatically. However, if the MSFC is already 
included in another active deployment job (that is, one that is in the Edit, Edit 
Open, Submitted, Submitted Open, Approved, or Rejected states), you 
cannot include the MSFC in the current deployment job. You must remove 
the MSFC from the other deployment job, discard the other deployment job, 
or include the FWSM in the other deployment job.

Edit deploy method 
button

Select to specify whether to deploy the generated configurations directly to the 
devices in the network or to files in a directory. See Edit Deploy Method Dialog 
Box, page O-17 for details.
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Deployment Status Details Dialog Box
The Deployment Status Details dialog box appears while configurations are being 
deployed to selected devices. It displays summary information about the job, 
status about the deployment to each device, and messages indicating why the 
deployment failed. 

In the Deployment Details table, select a row corresponding to a device to display 
deployment status messages for that device.

Note You can click Close to close this dialog box and continue working in Security 
Manager while deployment continues.

Navigation Path

From the Deploy Saved Changes dialog box, click Deploy. 

Related Topics

• Deploy Saved Changes Dialog Box, page O-3

• Deployment Job Approval, page 18-9

• Deploying Configurations in Non-Workflow Mode, page 18-38 

Add other devices 
button

Displays a list of all devices whether or not they contain proposed policy 
changes. You can select devices from this list to include in the All (or Modified 
Devices) tab. From the All tab, you can select to include those devices in your 
deployment job. See Add Other Devices Dialog Box, page O-23 for details.

Deploy button Deploys updated configuration information to the selected devices. See 
Deployment Status Details Dialog Box, page O-6.

Cancel button Cancels the operation and closes the dialog box.

Help button Opens help for this dialog box.

Table O-2 Deploy Saved Changes Dialog Box (continued)

Element Description
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Field Reference

Table O-3 Deployment Status Details Dialog Box

Element Description

Deployment Status Details

Progress Status Bar Visual representation and percentage of devices that were successfully updated.

Status Status of the deployment. Valid states are Deploying, Aborted, Successful, and 
Failed. For descriptions of these states, see Job States in Non-Workflow Mode, 
page 18-4.

Devices To Be 
Deployed

Total number of devices in the deployment session.

Devices Deployed 
Successfully

Number of devices that were updated successfully.

Devices Deployed 
With Errors

Number of devices that failed to be updated.

Deployment Details

Device Lists the names of the devices in the deployment session.

Status Shows the status of the deployment jobs. Valid states are Deploying, Aborted, 
Successful, and Failed. For a list of valid job states, see Job States in 
Non-Workflow Mode, page 18-4.

Summary Number of warnings, errors, and failures.

Method Method of deployment to the device. Valid methods are File and Device.

Config Displays the device configuration file. Double click the icon for the desired 
device. For more information, see Preview Config Dialog Box, page O-8.

Transcript Displays commands to and responses from the device during deployment. 
Double-click the icon for the desired device. 

Messages Warning, error, and failure messages.

Severity Icons representing the message severity. 

Description Description of the warning, error, or failure.

Action Information about how the warning, error, or failure might be corrected.

Refresh button Updates information displayed in the dialog box.
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Preview Config Dialog Box
Use the Preview Config dialog box to display the proposed changes, last deployed 
configuration, or current running configuration for specific devices.

If you use the Preview Config dialog box on a virtual sensor, the preview that you 
see is for the parent device, not the virtual sensor. The reason is that the 
configuration for a virtual sensor is stored on the parent device. 

Navigation Path

From the Edit Deploy Method dialog box, select a device and click Preview 
Config.

Related Topics

• Edit Deploy Method Dialog Box, page O-17

• Previewing Configurations, page 18-43

Abort button Aborts job deployment. You can abort deployment jobs only while they are in the 
Deploying, Scheduled, or Rolling Back state. Aborting a job stops deployment 
of configuration files to pending devices, but has no effect on devices to which 
deployments are in progress (commands are being written to a device) or to 
which deployment has already completed successfully.

The Abort state is a final state.

Close button Closes the dialog box.

Help button Opens help for this dialog box.

Table O-3 Deployment Status Details Dialog Box (continued)

Element Description
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Field Reference

Deployment—Workflow Mode
When in Workflow mode, the Deployment Manager window provides access to 
deployment job status and history and allows you to create and deploy jobs.

Table O-4 Preview Config Dialog Box

Element Description

Proposed 
commands to be 
downloaded

Complete proposed configuration that will be on the device after deployment, 
including the configuration changes you have made using Security Manager and 
the existing configuration on the device. 

Reference 
Configuration

Choose a configuration to compare against the proposed configuration:

• None—Leaves the reference configuration blank.

• Last deployed—Displays the last configuration that was imported from the 
device and compares it with the proposed configuration.

• Current running—Displays the current configuration running on the device 
and compares it with the proposed configuration.

First Difference 
button

Moves the cursor to the first difference noted between the proposed and reference 
configurations.

Previous Difference 
button

Moves the cursor to the previous difference noted between the proposed and 
reference configurations.

Current Difference 
button

Centers the currently selected difference on the page.

Next Difference 
button

Moves the cursor to the next difference noted between the proposed and 
reference configurations.

Last Difference 
button

Moves the cursor to the last difference noted between the proposed and reference 
configurations.

Print button Prints the active dialog box.

Close button Closes the dialog box.

Help button Opens help for this dialog box.
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The following topics help you understand the Deployment Manager window and 
create and manage deployment jobs:

• Deployment Manager Window (Workflow Mode), page O-10

• Summary Tab (Deployment Manager Window), page O-34

• Details Tab (Deployment Manager Window), page O-35

• History Tab (Deployment Manager Window), page O-36

Deployment Manager Window (Workflow Mode)
The Deployment Manager window contains four elements: the Deployment Job 
Table, Summary tab, Details tab, and History tab. These elements allow you to 
manage deployment of configurations to devices by helping you create and deploy 
jobs, monitor the status of deployment to devices, research deployment failures, 
and display job transaction histories.

Navigation Path

Click the Deployment Manager button on the Main toolbar.

Related Topics

• Job States in Workflow Mode, page 18-8

• Performing Additional Workflow-Mode Tasks, page 18-51

Field Reference

Table O-5 Deployment Manager Window (Workflow Mode)

Element Description

Name Name of the job. Click a job name to display details about the job. Information 
is displayed on the Deployment Details tab.

Last Action Date and time that the job or status were modified.

Note Uses the time zone of the server, not the time zone of the client.

Status State of each job. For a list of valid states, see Job States in Workflow Mode, 
page 18-8.

Changed By Name of the user who modified the job.
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Description Description for each job.

Create button Creates a new job. Click Create to display the Create a Job dialog box. See Create 
a Job Dialog Box, page O-12 for details about the elements on the page.

Open button Opens the selected job.

Close button Closes and save all changes made while the job was open. You can close a job 
when it is in the Edit Open or the Submit Open state.

Submit button Submits the job for approval. You can submit a job when it is in the Edit or the 
Edit Open state. Click Submit to display the Submit Deployment Job dialog box. 
See Submit Deployment Job Dialog Box, page O-23 for details about the 
elements in the dialog box.

Reject button Rejects the selected job if you are not satisfied with the configurations generated 
for the devices. Click Reject to display the Reject Deployment Job dialog box. 
See Discard Deployment Job Dialog Box, page O-26 for details about the 
elements in the dialog box.

Approve button Approves the selected job. This button is present only if job approval is enabled 
in the System Settings under the Admin tab. If so, jobs must be approved before 
they can be deployed. Click Approve to display the Approve Deployment Job 
dialog box. See Approve Deployment Job Dialog Box, page O-25 for details 
about the elements in the dialog box.

Discard button Discards the job. You can discard a job when it is in any state except Deployed, 
Deployment Failed, or Aborted. The job state is shown as discarded until the job 
is purged from the system. The job is purged from the system when you perform 
the purge action, either automatically as set on the Workflow Management page 
or manually. Click Discard to display the Discard Deployment Job dialog box. 
See Discard Deployment Job Dialog Box, page O-26 for details about the 
elements in the dialog box.

Refresh button Reloads job information from the Security Manager server. The latest job 
information is displayed in the Deployment table.

Table O-5 Deployment Manager Window (Workflow Mode) (continued)

Element Description
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Create a Job Dialog Box

You create deployment jobs to deploy configurations to devices.

Navigation Path

From the Deployment Manager window, click Create.

Related Topics

• Creating Deployment Jobs, page 18-51

• Working with Deployment, page 18-36

Deploy button Deploys the generated CLI commands to the selected devices or files. 

If the job is in the Approved state, the Deploy Job page appears. See Deploy Job 
Dialog Box, page O-27 for details about the elements on the page.

If the job is in deployed/failed/aborted state then the redeploy job page appears. 
See Redeploy a Job Dialog Box, page O-32 about the elements on the page.

Abort button Aborts a job that is in the Deploying state with a warning. The Abort state is a 
final state.

Rollback button Deploys the previously deployed configuration to the device. When you click 
Rollback, the Deployment Rollback page appears. See Deployment Rollback 
Dialog Box, page O-29 for details about the elements on the page.

Summary tab Displays summary information about the status of deployment jobs, such as the 
status of the job, number of devices deployed successfully, and number of device 
deployed with errors. For information about the elements displayed, see 
Summary Tab (Deployment Manager Window), page O-34.

Details tab Displays details about the deployment to specific devices, including information 
about errors, the proposed configuration, and the transcript of the download. For 
information about the elements displayed, see Details Tab (Deployment Manager 
Window), page O-35.

History tab Displays information about changes made to a job, including the state change, 
date and time the change took place, and the user who performed the change. For 
information about the elements displayed, see History Tab (Deployment 
Manager Window), page O-36.

Table O-5 Deployment Manager Window (Workflow Mode) (continued)

Element Description
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• Job States in Workflow Mode, page 18-8

• Deployment Manager Window (Workflow Mode), page O-10

Field Reference

Table O-6 Create a Job Dialog Box

Element Description

Job Name and Description

Name Name for the deployment job. Each job must have a unique name. Because the 
job name enables you to distinguish one job from another, you should assign a 
logical name that reflects the contents of the job.

Description Description for the deployment job that reflects the contents of the job.
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Select Devices

Device Selector All devices on which policy changes were made but were not yet deployed. Select 
the check box next to the device to include in the deployment job. By default, all 
devices with policy changes are selected. You can deselect any of the selected 
devices if you do not want them included in the current job. 

Note Modifying a subset of devices that are part of a VPN might make the VPN 
inoperable. If you select a subset of devices that are part of a VPN, then 
click OK, you will get a warning. See Warning - Partial VPN 
Deployment Dialog Box, page O-16.

Also consider the following:

• You cannot select devices that were included in other deployment jobs that 
are in an active state (Edit, Edit Open, Submitted, Submitted Open, 
Approved, or Rejected). You can select devices that were included in other 
deployment jobs that are in the Deployed, Failed, Discarded, or Aborted 
states.

• In Catalyst 6500/7600, Firewall service modules (FWSMs) and Intrusion 
Detection System service modules (IDSMs) contain virtual devices. The 
module and the virtual devices are each considered by Security Manager to 
be separate devices.

• Some changes to the FWSM might require the Catalyst 6500/7600 
Multiservice function card (MSFC) to be updated as well. If you select a 
FWSM that has these types of changes, Security Manager notifies you that 
you must include the MSFC in the deployment job, and it selects the MSFC 
device for you. However, if the MSFC is already included in another active 
deployment job (that is, one that is in the Edit, Edit Open, Submitted, 
Submitted Open, Approved, or Rejected states), you cannot include the 
MSFC in the current deployment job. You must remove the MSFC from the 
other deployment job, discard the other deployment job, or include the 
FWSM in the other deployment job.

Edit deploy method 
button

Configures whether to deploy the generated configurations directly to the devices 
in the network or to files in an output directory. See Table O-8 for details.

Table O-6 Create a Job Dialog Box (continued)

Element Description
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Add other devices 
button

Displays a list of all devices whether or not they contain proposed policy 
changes. You can select devices from this list. See Add Other Devices Dialog 
Box, page O-23 for details.

Job State—Fields displayed when workflow is turned on without an approver.

Leave the job in the 
edit state

Saves the job so that you can make additional changes later. 

Approve the job Approves the job so that it can be deployed later.

Approver 
Comments

Enter comments about the job. Appears only if you clicked the Approve the job 
radio button.

Deploy the job Deploys the job.

Deployment 
Options

Appears only if you clicked the Deploy the job radio button. Select when to 
deploy the job. Valid options are Schedule and Deploy Now. 

Enter Deployment 
Time

Appears only if you selected Schedule in the Deployment Options field. 

• Date—Enter the month, date, and year that you want the job to be deployed. 
You can also click the calendar next to the field to select a date.

• Time—Enter the time that you want the job to be deployed. Use the 24-hour 
clock format. 

Note The time you enter should reflect the time zone of the server not 
necessarily the time zone of the client.

Note The minimum amount of time for which you can schedule a job is 5 
minutes from the current time.

Deployment 
Comments

Enter a comment to the approver. For example, you might tell the approver why 
you are deploying the job.

Job State—Fields displayed when workflow is turned on with an approver. 

Submit the job Submits the job for approval. By default this check box is selected. 

Table O-6 Create a Job Dialog Box (continued)

Element Description
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Warning - Partial VPN Deployment Dialog Box

When you create a deployment job from the Create a Job dialog box and the job 
contains devices in a VPN, you must select all of the devices in the VPN. If you 
select a subset of devices and try to deploy to only those devices, a Warning - 
Partial VPN Deployment dialog box appears. See Create a Job Dialog Box, 
page O-12 for additional information.

Navigation Path

From the Create a Job dialog box, if you do not select all devices in a VPN, the 
Warning - Partial VPN Deployment dialog box appears.

Related Topics

• Create a Job Dialog Box, page O-12

• Creating Deployment Jobs, page 18-51

Field Reference

Approver email Email address of the approver. This field can be edited only if the Submit the job 
check box is selected. To edit the default email address, go to Tools > Security 
Manager Administration > Workflow.

Approver 
Comments

Appears only if the Submit the job check box is selected. Enter approver 
comments if any. 

OK button Saves your changes and closes the dialog box. 

Cancel button Closes the dialog box without saving your changes.

Help button Opens help for this dialog box.

Table O-6 Create a Job Dialog Box (continued)

Element Description

Table O-7 Partial VPN Deployment Warning Dialog Box

Element Description

VPN Name of the VPN.

Missing Devices All devices in the VPN that were not selected for deployment. 

Is Device in Other Job Information about the missing devices. 
O-16
User Guide for Cisco Security Manager 3.1

OL-11501-03



 

Appendix O      Deployment User Interface Reference
    Deployment—Workflow Mode
Edit Deploy Method Dialog Box

The Edit Deploy Method dialog box enables you to specify whether to deploy the 
generated configurations directly to the devices in the network or to files in an 
output directory.

Navigation Path

From the Create a Job dialog box, click Edit Deploy Method. 

Related Topics

• Understanding Deployment Methods, page 18-11

• Creating Deployment Jobs, page 18-51

Field Reference

Deploy to All Devices 
in VPN button

Deploys to all devices in the VPN. 

Note You can deploy to all devices in VPN only if the devices are not in other 
deployment jobs. If the devices are in other deployment jobs and you 
click this button, an error message is displayed.

Deploy to Selected 
Devices button

Deploys only to the selected devices in the Create a Job page.

Table O-7 Partial VPN Deployment Warning Dialog Box

Element Description

Table O-8 Edit Deploy Method Dialog Box

Element Description

Device Name of the device.
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Method Deployment method to use. Valid methods are:

• Device—(Default) Deploys the configuration directly to the device or to the 
transport mechanism specified for the device. For more information, see 
Deploying to a Device, page 18-11.

• File—Deploys the configuration file to a file on a selected server. If you 
select File, specify the directory to which you want to deploy the 
configuration file in the Destination column. For more information, see 
Deploying to a File, page 18-13.

Note To set the deployment method for more than one device at a time, select 
the desired rows and right-click to display the Edit Selected Deployment 
Method dialog box. For more information, see Edit Selected Deployment 
Method Dialog Box, page O-19.

Destination If you selected File in the Method field, enter the directory to which you want to 
deploy the configuration file or click Browse to select from a list of available 
directories.

Preview Config 
button

Displays the proposed changes, last deployed configuration, or current running 
configuration for specific devices. Select a row, then click Preview Config. For 
more information, see Preview Config Dialog Box, page O-21.

Table O-8 Edit Deploy Method Dialog Box (continued)

Element Description
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Edit Selected Deployment Method Dialog Box

Use this dialog box to change the deployment method for multiple devices. If you 
select File, you can also set the destination directory for those devices.

Navigation Path

From the Edit Deploy Method dialog box, select the desired rows and right-click 
to display the Edit Selected Deployment Method dialog box.

Out of Bound 
Change Behavior

Click the radio button corresponding to the action you want Security Manager to 
take regarding changes made to directly on the device using the CLI:

• Overwrite changes and show warning—When configurations are deployed, 
Security Manager uploads the device’s current configuration and compares 
it against the configuration it has in its database. If changes were made to the 
device manually, Security Manager continues with the deployment and 
displays a warning notifying you of this action.

• Cancel deployment—When configurations are deployed, Security Manager 
uploads the device’s current configuration and compares it against the 
configuration it has in its database. If changes were made to the device 
manually, Security Manager cancels the deployment and displays a warning 
notifying you of this action.

• Do not check for changes—Security Manager does not check for changes 
and deploys the changes to the device.

The default is set under Tools > Security Manager Administration. For more 
information, see Chapter 20, “Using Tools.”

OK button Saves your changes and closes the dialog box. 

Cancel button Closes the dialog box without saving your changes.

Help button Opens help for this dialog box.

Table O-8 Edit Deploy Method Dialog Box (continued)

Element Description
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Related Topics

• Edit Deploy Method Dialog Box, page O-17

Field Reference

Preview Messages Dialog Box

Before displaying a proposed configuration, Security Manager validates it. If any 
errors or warnings occur, the Preview messages dialog box appears.

Navigation Path

From the Edit Deploy Method dialog box, select the desired device and click 
Preview Config. If any errors or warnings occur, the Preview messages dialog 
box appears.

Table O-9 Deploy Method Dialog Box

Element Description

Method Deployment method to use. Valid methods are:

• Device—Deploys the configuration directly to the device.

• File—Deploys the configuration file to a file on a selected server. If you 
select File, specify the directory to which you want to deploy the 
configuration file in the Destination column.

The main advantage of deploying configurations to files is that you can 
create configurations for devices that are not yet in place in your network. If 
you deploy to files, Security Manager creates a configuration file for each 
device in the job, in the format DeviceName.cfg. You must specify the 
directory on the Security Manager server in which to create the configuration 
files. Configuration files are in TFTP format so that you can upload them to 
your devices using TFTP.

If you deploy to files, you are responsible for transferring the configurations 
to your devices. Security Manager assumes that you have done this, so the 
next time you deploy to the same devices, the generated incremental 
commands are based on the configurations from the previous deployment.

Destination If you selected File in the Method field, enter the directory to which you want to 
deploy the configuration file or click Browse to select from a list of available 
directories.
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Related Topics

• Edit Deploy Method Dialog Box, page O-17

Field Reference

Preview Config Dialog Box

Use the Preview Config dialog box to display the proposed changes, last deployed 
configuration, or current running configuration for specific devices.

Navigation Path

From the Edit Deploy Method dialog box, select the desired device and click 
Preview Config.

Related Topics

• Edit Deploy Method Dialog Box, page O-17

• Deployment Job Approval, page 18-9

• Previewing Configurations, page 18-43

Table O-10 Preview Messages Dialog Box

Element Description

Messages Warning, error, and failure messages.

Severity Icons representing the message severity. 

Message Detail Description of the warning, error, or failure.

Solution Information about how the warning, error, or failure might be corrected.

OK button Closes the dialog box and displays the Preview Config Dialog box. For more 
information, see Preview Config Dialog Box, page O-8.

Help button Opens help for this dialog box.
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Field Reference

Table O-11 Preview Config Dialog Box

Element Description

Proposed 
commands to be 
downloaded

Shows the complete proposed configuration that will be on the device after 
deployment, including the configuration changes you have made using Security 
Manager and the existing configuration on the device. 

Reference 
Configuration

Shows one of the following, as selected:

• None—Displays the proposed configuration and compares it with the last 
deployed configuration (if there is one).

• Last deployed—Displays the last configuration that was imported from the 
device and compares it with the proposed configuration.

• Running config—Displays the running configuration on the device and 
compares it with the proposed configuration.

Buttons

First Difference 
button

Moves the cursor to the first difference noted between the proposed and reference 
configurations.

Previous Difference 
button

Moves the cursor to the previous difference noted between the proposed and 
reference configurations.

Current Difference 
button

Centers the currently selected difference on the page.

Next Difference 
button

Moves the cursor to the next difference noted between the proposed and 
reference configurations.

Last Difference 
button

Moves the cursor to the last difference noted between the proposed and reference 
configurations.

Print button Prints the active dialog box.

Close button Closes the dialog box.

Help button Opens help for this dialog box.
O-22
User Guide for Cisco Security Manager 3.1

OL-11501-03



 

Appendix O      Deployment User Interface Reference
    Deployment—Workflow Mode
Add Other Devices Dialog Box

The Add Other Devices dialog box enables you to select additional devices that 
do not have proposed policy changes to be included in your deployment job. You 
might want to do this if a device was manually modified and you want to return 
the device to its previous configuration (the configuration stored in the Security 
Manager database).

Navigation Path

From the Create a Job dialog box, click Add other devices.

Related Topics

• Create a Job Dialog Box, page O-12

• Creating Deployment Jobs, page 18-51

• Including Devices in Deployment Jobs, page 18-10

Field Reference

Submit Deployment Job Dialog Box

When workflow is turned on with a deployment job approver, jobs must be 
submitted for approval before policy changes can be deployed to devices.

Table O-12 Add Other Devices Dialog Box

Element Description

Available Devices Displays a list of all devices whether or not they contain proposed policy 
changes. Select the devices to include in the job; then click >> to move the 
devices to the Selected Devices field.

You can display a subset of devices based on the filtering criteria you define. For 
more information, see Filtering the Device Selector, page 5-28.

Selected Devices Displays a list of devices you selected for inclusion in the job. These devices do 
not have any proposed policy changes.

OK button Saves your changes and closes the dialog box. 

Cancel button Closes the dialog box without saving your changes.

Help button Opens help for this dialog box.
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Navigation Path

To access this dialog box, do one of the following:

• From the Create a Job dialog box, click the Submit the job checkbox.

• From the Deployment Manager window, select the job and click Submit.

Related Topics

• Submitting Deployment Jobs, page 18-55

• Create a Job Dialog Box, page O-12

• Deployment Manager Window (Workflow Mode), page O-10

• Job States in Workflow Mode, page 18-8

Field Reference

Reject Deployment Job Dialog Box

When workflow is turned on with a deployment job approver, jobs must be 
submitted to an approver who has the authority to approve or reject it. When jobs 
are rejected, policy changes cannot be deployed to devices. After a job is rejected, 
it can be opened for editing or discarded.

If you want the submitter to make changes to the job, you can specify those 
changes in the comments field.

Table O-13 Submit Deployment Dialog Box

Element Description

Approver Email address of the person to be notified of your submission. Leave the default 
email address or enter a new email address.

You can change the default email address under Tools > Security Manager 
Administration > Workflow.

Comment Enter a brief explanation of the job or other pertinent information.

OK button Saves your changes and closes the dialog box. 

Cancel button Closes the dialog box without saving your changes.

Help button Opens help for this dialog box.
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Navigation Path

From the Deployment Manager window, select the job (must be in Submitted 
state) and click Reject.

Related Topics

• Approving and Rejecting Deployment Jobs, page 18-56

• Deployment Manager Window (Workflow Mode), page O-10

• Job States in Workflow Mode, page 18-8

Field Reference

Approve Deployment Job Dialog Box

In Workflow mode with a deployment job approver, jobs must be submitted for 
review. Then, an approver either approves or rejects the job. When jobs are 
approved, policy changes are deployed to devices.

If you want the submitter to make changes to the job, you can cancel this operation 
and reject the job instead.

Navigation Path

From the Deployment Manager window, select the job (must be in Submitted 
state) and click Approve.

Related Topics

• Approving and Rejecting Deployment Jobs, page 18-56

• Deployment Manager Window (Workflow Mode), page O-10

Table O-14 Reject Deployment Job Dialog Box

Element Description

Comment Enter a brief explanation of why you are rejecting the activity and suggested revisions.

OK button Saves your changes and closes the dialog box. 

Cancel 
button

Closes the dialog box without saving your changes.

Help button Opens help for this dialog box.
O-25
User Guide for Cisco Security Manager 3.1

OL-11501-03



 

Appendix O      Deployment User Interface Reference
    Deployment—Workflow Mode
• Job States in Workflow Mode, page 18-8

Field Reference

Discard Deployment Job Dialog Box

When you discard a job, it is no longer active. It cannot be edited, submitted, 
approved, or deployed. For tracking purposes, you can enter a comment 
explaining why you are discarding the job.

Navigation Path

From the Deployment Manager window, select the job and click Discard.

Related Topics

• Discarding Deployment Jobs, page 18-57

• Deployment Manager Window (Non-Workflow Mode), page O-2

• Deployment Manager Window (Workflow Mode), page O-10

• Job States in Non-Workflow Mode, page 18-4

• Job States in Workflow Mode, page 18-8

Table O-15 Approve Deployment Job Dialog Box

Element Description

Comment Enter a brief explanation of why you are approving the job.

OK button Saves your changes and closes the dialog box. 

Cancel 
button

Closes the dialog box without saving your changes.

Help button Opens help for this dialog box.
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Field Reference

Deploy Job Dialog Box

Deploying a job begins the process of connecting to devices specified in the job 
and downloading updated configuration files.

Caution You must configure at least one policy on a device before deploying to that device. 
If you deploy to a device without assigning at least one policy, the device's current 
configuration is overwritten with a blank configuration.

Navigation Path

From the Deployment Manager window, select the job (if using Workflow mode, 
must be in Approved state) and click Deploy.

Related Topics

• Deployment Manager Window (Non-Workflow Mode), page O-2

• Deployment Manager Window (Workflow Mode), page O-10

• Deploying Configurations in Workflow Mode, page 18-41

• Job States in Workflow Mode, page 18-8

Table O-16 Discard Deployment Job Dialog Box

Element Description

Comment Enter a brief explanation of why you are discarding the job.

OK button Saves your changes and closes the dialog box. 

Cancel 
button

Closes the dialog box without saving your changes.

Help button Opens help for this dialog box.
O-27
User Guide for Cisco Security Manager 3.1

OL-11501-03



 

Appendix O      Deployment User Interface Reference
    Deployment—Workflow Mode
Field Reference

Abort Deployment Job Dialog Box

You can manually halt a job that is in the Deploying state. Only pending 
deployments to devices are halted. Successful deployments and those that are in 
progress are not affected by the abort operation. After aborting a job, no other 
actions can be taken on the job.

Navigation Path

From the Deployment Manager window, select the job (must be in Deploying 
state) and click Abort.

Table O-17 Deploy Job Dialog Box

Element Description

Deployment 
Options

Select when you want to deploy the job. Valid options are Schedule and Deploy 
Now. 

Enter Deployment Appears only if you selected Schedule in the Deployment Options field. 

• Date—Enter the month, date, and year that you want the job to be deployed. 
You can also click the calendar next to the field to select a date.

• Time—Enter the time that you want the job to be deployed. Use the 24-hour 
clock format.

Note The time you enter should reflect the time zone of the server not 
necessarily the time zone of the client.

Note The minimum amount of time for which you can schedule a job is 5 
minutes from the current time.

Deployment 
Comments

Enter comments regarding the job. For example, you might describe the reason 
that you are deploying the job.

OK button Saves your changes and closes the dialog box. 

Cancel button Closes the dialog box without saving your changes.

Help button Opens help for this dialog box.
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Related Topics

• Aborting Deployment Jobs, page 18-47

• Deployment Manager Window (Non-Workflow Mode), page O-2

• Deployment Manager Window (Workflow Mode), page O-10

• Job States in Non-Workflow Mode, page 18-4

• Job States in Workflow Mode, page 18-8

Field Reference

Deployment Rollback Dialog Box

If you deploy configurations to devices, and then determine that there is 
something wrong with the new configurations, you can revert to and deploy the 
previous configurations for those devices. 

Note There is limited support for the rollback function on Catalyst 6500/7600. VLAN 
configuration changes made through the CVDM home page are not captured in 
the running configuration of the Catalyst 6500/7600. Therefore, they are not 
included in the configurations saved to Security Manager database after each 
deployment. If you want to use the rollback function in this case, you need to 
reconfigure the VLANs on the CVDM home page after rolling back the 
configuration.

Table O-18 Abort Deployment Job Dialog Box

Element Description

OK button Confirms the abort operation.

Cancel 
button

Stops the abort operation and closes the dialog box.

Help button Opens help for this dialog box.
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Note The rollback operation causes the devices in the job to reload. If you do not want 
to reload devices, instead you can redeploy the job or create and deploy a new job 
with the desired configuration changes. Use the rollback operation only in 
extreme circumstances.

Navigation Path

From the Deployment Manager window, select the job (must be in Deployed or 
Failed state) and click Rollback. Then click OK when prompted to confirm the 
operation.

Related Topics

• Rolling Back Configurations to Devices, page 18-48

• Deployment Manager Window (Non-Workflow Mode), page O-2

• Deployment Manager Window (Workflow Mode), page O-10

• Job States in Non-Workflow Mode, page 18-4

• Job States in Workflow Mode, page 18-8

Field Reference

Table O-19 Deployment Rollback Dialog Box

Element Description

Selection When selected, reverts to the previous configuration. Select the check box next 
to a device for which to revert the configuration. By default, all the devices with 
the status “Succeeded” are selected.

Name Name of the device. 

Method Deployment method, File or Device.

Note You cannot roll back the configuration if the deployment method is File. 
You can only roll back the configuration if the deployment method is 
Device.

Previous Status Status of the previous deployment. 

Note If there are no previous configurations on the device in the configuration 
archive, you cannot use the rollback feature.
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Rollback Confirmation Dialog Box

Rollback deploys the previously deployed configuration to the device. 

Note The rollback operation causes the devices in the job to reload. If you do not want 
to reload devices, you can redeploy the job or create and deploy a new job with 
the desired configuration changes instead. It is recommended that the rollback 
operation only be used in extreme circumstances.

Navigation Path

From the Deployment Manager window, select the job (must be in Deployed or 
Failed state) and click Rollback.

Related Topics

• Aborting Deployment Jobs, page 18-47

• Job States in Non-Workflow Mode, page 18-4

• Job States in Workflow Mode, page 18-8

Last Updated By Name of previous job that updated the device.

Preview Config 
button

Displays the previous configuration on the device. Select a row, then click 
Preview Config.

OK button Confirms the rollback operation.

Cancel button Stops the rollback operation and closes the dialog box.

Help button Opens help for this dialog box.

Table O-19 Deployment Rollback Dialog Box (continued)

Element Description
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Field Reference

Redeploy a Job Dialog Box

If a job is in a Failed or Aborted state, you can deploy the job again. If desired, 
you can also add devices to which deployment was successful.

Caution You must configure at least one policy on a device before deploying to that device. 
If you deploy to a device without assigning at least one policy, the device's current 
configuration is overwritten with a blank configuration.

Navigation Path

Do one of the following:

• (Non-Workflow mode) From the Deployment Manager window, select the job 
(must be in Aborted or Failed state) and click Redeploy.

• (Workflow mode) From the Deployment Manager window, select the job 
(must be in the Aborted or Failed state and click Deploy. 

Related Topics

• Redeploying Configurations to Devices, page 18-45

• Job States in Non-Workflow Mode, page 18-4

• Job States in Workflow Mode, page 18-8

Table O-20 Rollback Confirmation Dialog Box

Element Description

OK button Confirms the rollback operation.

Cancel 
button

Stops the rollback operation and closes the dialog box.

Help button Opens help for this dialog box.
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Field Reference

Table O-21 Redeploy a Job Dialog Box

Element Description

Selection When selected, includes a device in the deployment. By default, all the devices 
with the status “Failed” are selected.

Name Name of the device.

Method Deployment method, File or Device. If you select File, specify the directory to 
which you want to deploy the configuration file in the Destination column.

Destination If you selected File in the Method field, enter the directory to which you want to 
deploy the configuration file or click Browse to select from a list of available 
directories.

Previous status Status of the previous deployment.

Last Updated By Name of previous job.

Preview Config 
button

Displays the previous configuration on the device. Select a row, then click 
Preview Config.

Out of Bound 
Change Behavior

Click the radio button corresponding to the action you want Security Manager to 
take regarding changes made to directly on the device using the CLI:

• Overwrite changes and show warning—When configurations are deployed, 
Security Manager uploads the device’s current configuration and compares 
it against the configuration it has in its database. If changes were made to the 
device manually, Security Manager continues with the deployment and 
displays a warning notifying you of this action.

• Cancel deployment—When configurations are deployed, Security Manager 
uploads the device’s current configuration and compares it against the 
configuration it has in its database. If changes were made to the device 
manually, Security Manager cancels the deployment and displays a warning 
notifying you of this action.

• Do not check for changes—Security Manager does not check for changes 
and deploys the changes to the device.

The default is set under Tools > Security Manager Administration. For more 
information, see Chapter 20, “Using Tools.”

OK button Confirms the deployment operation.

Cancel button Stops the deployment operation and closes the dialog box.
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Summary Tab (Deployment Manager Window)
You can display summary information about deployment jobs, such as the status 
of the job, number of devices deployed successfully, and number of devices 
deployed with errors.

Navigation Path

Click the Deployment Manager button on the Main toolbar, then click the 
Summary tab.

Related Topics

• Deployment Manager Window (Workflow Mode), page O-10

Field Reference

Help button Opens help for this dialog box.

Table O-21 Redeploy a Job Dialog Box (continued)

Element Description

Table O-22 Summary Tab (Deployment Manager Window)

Element Description

Deployment Job 
Name

Name of the job.

Deployment Status Status of the job. See the Deployment Status column in Table O-5 for detailed 
descriptions of the statuses.

Progress Status Progress bar visually indicates the progress of the deployment. Next to the 
progress bar, displays the percentage complete and the ratio of remaining to total 
number of devices to be deployed.

Number Of Devices 
To Be Deployed

Total number of devices included in the job.

Number Of Devices 
Deployed 
Successfully

Number of devices that were successfully updated.
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Details Tab (Deployment Manager Window)
You can display details about the deployment to specific devices, including 
information about errors, the proposed configuration, and the transcript of the 
download.

Navigation Path

Click the Deployment Manager button on the Main toolbar, then click the Details 
tab.

Related Topics

• Deployment Manager Window (Workflow Mode), page O-10

Field Reference

Number Of Devices 
Deployed with 
Errors

Number of devices that failed to be updated.

Table O-22 Summary Tab (Deployment Manager Window) (continued)

Element Description

Table O-23 Details Tab (Deployment Manager Window)

Element Description

Details Table

Device Names of the devices in the deployment job.

Status Status indicating whether the deployment passed, failed, or passed with 
warnings.

Summary Number of warnings, errors, and failures.

Method Method of deployment to the device. Valid methods are File and Device. If the 
method is File, the path and file name are also shown.

Config Double click the icon to display the configuration file for the selected device. See 
Preview Config Dialog Box, page O-8 for details about the dialog box that 
appears.
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History Tab (Deployment Manager Window)
You can display information about changes made to a job, including the state 
change, date and time the change took place, and the user who performed the 
change.

Navigation Path

Click the Deployment Manager button on the Main toolbar and click the History 
tab.

Related Topics

• Deployment Manager Window (Workflow Mode), page O-10

Field Reference

Transcript Double click the icon to display a transcript of the download attempt to the 
device.

Results

Messages Warning, error, and failure messages.

Severity Icons representing the message severity. 

Message Detail Description of the warning, error, or failure.

Solution Information about how the warning, error, or failure might be corrected.

Close button Closes the dialog box.

Help button Opens help for this dialog box.

Table O-23 Details Tab (Deployment Manager Window) (continued)

Element Description

Table O-24 Deployment Job History Tab

Element Description

State Changed To State of the deployment job. For a list of valid states, see Job States in Workflow 
Mode, page 18-8.

By User Username of the person who performed the action on the deployment job.
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Time Date and time that the action was performed on the deployment job.

Note The timestamps shown on the History tab use the time zone of the server, 
not the time zone of the client.

Comment Comment that was entered when the action was performed on the deployment 
job.

Table O-24 Deployment Job History Tab

Element Description
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